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2016 Knowledge-Based Preparations, Compilations and Reviews for ProSystem fx® Knowledge Coach

Welcome to 2016 Knowledge-Based Preparations, Compilations and Reviews for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2016 release of Knowledge Based Preparations, Compilations
and Reviews. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998.
Additional information is available on CCH Support Online.

New in this Release

Knowledge-Based Preparations, Compilations and Reviews is designed to help the accountant efficiently and effectively perform
financial statement preparation engagements, compilations, and reviews of nonpublic commercial entities in accordance with
Statements on Standards for Accounting and Review Services (SSARS) issued by the Accounting and Review Services Committee
(ARSC) of the American Institute of Certified Public Accountants (AICPA).

The Knowledge-Based Preparation, Compilation, and Review (KBPCR) Methodology emphasizes using knowledge of the entity to
perform preparation, compilation, and review engagements by facilitating the flow of information so that the understanding obtained in
each process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report, if any, is issued. This edition includes specific up-to-date guidance for conducting preparation,
compilation, and review engagements in accordance with the SSARS. This document is published for the purpose of communicating, to
users of the toolset, updates and enhancements included in the current version. This document is not, and should not be used as, a
program to update the engagement documentation of an engagement started in a previous version of this product.

This document is published for the purpose of communicating the updates and enhancements included in the current version to users
of the toolset. This document is not, and should not be used as an audit program to update the audit documentation of an engagement
started in a previous version of this product.

This is the sixth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2016 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2016 edition of Knowledge-Based Preparations, Compilations and Reviews features numerous enhancements, including:

¢ Many new and modified procedures and steps in all three titles for better clarification and compliance with current accounting
guidance, see KCO-001 for roll forward considerations;

¢ Anew tailoring question in the Overall Tailoring Questions Workpaper of each title (PRP-100, CMP-100, REV-100) about
whether the engagement is for personal financial statements; the result of this question will show/hide procedures in the
Overall Program (PRP-101, CMP-101, REV-101); see KCO-001 for more details;

¢ A Not-for-Profit Industry-Specific section has been added to KBCR-901 Financial Statement Disclosures Checklist;

¢ New Reports and Correspondence documents.

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20Comp%20Prep%20Rev%20Title%200verview%20for%2
OKnowledge%20Coach%20Users.pdf



http://support.cch.com/productsupport/
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20Comp%20Prep%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20Comp%20Prep%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current accounting guidance:

¢ Statement on Standards for Accounting and Review Services No. 21 (SSARS-21), Clarification and Recodification (including AR-C
Section 70, Preparation of Financial Statements; AR-C Section 80, Compilation Engagements; and AR-C Section 90, Review of
Financial Statements);

AICPA Guide Preparation, Compilation and Review Engagements;
AICPA Statement on Quality Control Standards No. 8 (QC Section 10), A Firm's System of Quality Control (Redrafted);
Revised AICPA Code of Professional Conduct (Code), including ET Section 1.295, Nonattest Services; and
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2014/2015 Audit Risk Alert Developments in Review, Compilation, and Financial Statement Preparation Engagements—2014/15.
Important Notes

¢ Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

¢ If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
¢ Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach

workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements
¢ This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5,
and 2016 Financial Statement Base or higher. If you have not installed the ProSystem fx® Engagement 7.5 and Knowledge 2.5,

ensure that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please contact
Technical Support at 1-800-PFX-9998 for detailed instructions.

¢ A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2016 Knowledge Based Preparations, Compilations and Reviews from the ProSystem fx ®Knowledge Coach Updates
section of the ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach,
then select the Knowledge Coach Series and Download file link next to the 2016 Knowledge-Based Preparations, and/or 2016
Knowledge-Based Compilations and/or the 2016 Knowledge-Based Reviews titles. On some occasions the content package file (.KCP)
will download with the extension changed to .ZIP. If this occurs, please change the extension of the downloaded file to KCP using all
capital letters.

You must install the 2016 Financial Statement Base title before installing the 2016 Knowledge Based Preparations, 2016 Knowledge-
Based Compilations and 2016 Knowledge-Based Reviews.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2016 Knowledge-Based Preparations, Compilations and Reviews (7/28/16). KCP download are proprietary files that must be
installed from within Engagement. Save each KCP file to a location on your local drive and follow the Installation Instructions included
in the Release Bulletin.


http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2016 Knowledge Based Preparations, Compilations and Reviews, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module license as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2016 Knowledge-Based Preparations, Compilations and Reviews titles have been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2016
Knowledge-Based Preparations, Compilations and Reviews.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Accounting Research Manager

CCH's Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Available on ARM, the Knowledge-Based Preparations, Compilations and Reviews Guide helps you comply with the most recent
professional standards and guidance for the conduct preparations, compilations and reviews and to integrate the use of practice aids,
tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are
available in Knowledge Coach.

If you subscribe to an ARM library that includes Preparation, Compilation and Review content, you can link directly to source material
from Resources within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the


https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx

FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Preparations, Compilations and Reviews Guide
on ARM, you can take advantage of references to the guide material from within the Knowledge Coach documents.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Using Your Knowledge Coach Content

MNew Knowledge Coach Workpaper -

To use your Knowledge Coach Workpaper Templates,
open a binder in ProSystem fx® Engagement, select
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content you would like to use. You can only select detalls,

titles you have installed. The information displayed
changes to reflect the workpaper organization
available for the selected title. Select the Knowledge
Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper
Properties dialog appears. Each workpaper name is
automatically loaded into the Name field. Add a
workpaper index in the Index field and make any
Name modifications you desire. You can also modify
the tab location or the roll forward settings for each
workpaper. Then click OK. The integrated Knowledge
Coach workpaper is now inserted into your 0K || Cancel || Hebp
engagement binder. For more information on how to

use Knowledge Coach workpapers in your binder, see

the Knowledge Coach User Guide.

Figure 1 - New Knowledge Coach Workpaper

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Preparation, Compilation and Review (KBPCR) Methodology - Allows the results of one set of procedures to become
the input for the next. The key components of the KBPCR methodology include:

¢ An Overview that guides accountants through the KBPCR methodology;

¢ Knowledge-Based Preparation, Compilation, and Review documents, integral to the overall engagement process, that contain
steps and procedures required by SSARSs.

¢ Customizable Preparation, Compilation and Review Programs that take accountants through related steps and procedures;

¢ Practice Aids to help accountants complete steps or processes outlined in the Knowledge-Based Preparation, Compilation and
Review documents and Programs;


http://www.accountingresearchmanager.com/

Accountant’s Reports that provide a variety of sample accountant’s opinions on financial statements; and

Correspondence documents that provide sample letters to be used to comply with SSARS requirements and in many other
common situations.

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2016 Knowledge-
Based Preparations, Compilations and Reviews are designed around the AICPA’s SSARS standards to assist accountants by:

e Facilitating compliance with SSARS;
e Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and
e Enhancing engagement documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently
by eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement,
and documenting the link between risks identified and procedures performed. PRP-100 Tailoring Question Workpaper, CMP-100
Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper are documents in Knowledge Coach that presents
engagement-level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the
questions helps the accountant avoid duplication and unnecessary workpapers.

Before you begin your engagement, please review the guidance in PRP-101 Overall Preparation Program, CMP-101 Overall
Compilation Program or REV-101 Overall Review Program. These workpapers are intended to be your road map through the
Knowledge-Based methodology. You should start your engagement with PRP-100 Tailoring Question Workpaper, CMP-100
Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper and PRP-101 Overall Preparation Program, CMP-101
Overall Compilation Program or REV-101 Overall Review.

The Risk Assessment features have been disabled since the 2012 Knowledge-Based Compilations and Review Title for Knowledge
Coach. Refer to KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102 Review:
Significant Matters to accumulate and review significant issues and findings. PRP-801 Preparation Program, CMP-801
Compilation Program: Significant Risks and Uncertainties and REV-802 Review Program: Significant Risks and Uncertainties
provides a guide for implementing the guidance related to the disclosure of certain significant risks and uncertainties.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file.

Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the SSARS and accounting standards issued by the AICPA. Also, if you subscribe to the
Knowledge-Based Preparations, Compilations and Reviews Guide on ARM, you can take advantage of links to the guide material
from within the Knowledge Coach documents.

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help accountants work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.



Download 2016 Knowledge-Based Preparations, Compilations and

Description: Reviews(7/28/2016)

Version: Engage.ment. v. 7.5 with Knowledge Coach 2.5 or higher and
2016 Financial Statement Base

Release Date: July 2016

File size: 18MB

Approx. Download 42 minutes at 56 kbps

Time:

License: Full Version

Platforms: Windows® 7, 8, 8.1, 10

Office: Microsoft® Office 2010 or higher required

Contact Information

¢ For ademo or to purchase additional titles as they become available ~1-800-PFX-9998

¢ Technical Support 1-800-PFX-9998

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.



